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User guide

Codefusion Studio (CFS) is an embedded software development platform based on Microsoft's Visual Studio

and MCUs by providing intuitive tools for newcomers while enabling advanced features for expert embedded
developers.

About CFS

e The Installation process

» Project creation and management

» Debugging single and multi-core applications
» Additional Tools

« Uninstalling

See Help for details on how to get support with CodeFusion Studio.

@ Note

You can toggle between light and dark mode using the sun and moon icons on to the top right of this page.

Page 10/ 138



About

Page 11/138



About

Learn about CodeFusion Studio, the supported processors, and how to get help.

« Understand why we built CodeFusion Studio and our Purpose.
o See what Features CodeFusion Studio has to offer.

e Learn how to Navigate CodeFusion Studio.

Verify the Supported processors

Get Help with CodeFusion Studio.
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Purpose

Embedded software engineering is an increasingly complex problem to solve. As technology marches toward
multi-core, multi-architecture solutions, time to market and development resources are shrinking. Engineers
are expected to deal with this complexity with tools, middleware, and SDKs designed for a single-core,
single-architecture world. Those tools are often proprietary, single-vendor solutions that may become
obsolete. Code generated from these tools is typically inflexible, with limited usefulness in the real world

Why CodeFusion Studio

Embedded engineers need open-sourced tools designed for multi-core systems that provide system visibility
and offer the flexibility to adapt to their development needs, without having to worry about activation servers,
licensing fees, or cobbling together their own makeshift tools.

Open source

Analog Devices' CodeFusion Studio adheres to an Open Source First design principle. It provides embedded
engineers with robust, extensible tools that they own, designed for long-term use and customization.

o Permissively-licensed tools that can be modified to suit unique needs
» Open-source toolchains and critical software components

» Integration with Zephyr, an open-source operating system

System visibility
CodeFusion Studio provides better system visibility into complex systems.

binaries, reducing time spent on debugging and profiling. (image 2)(image 3)(image4)

« Simultaneous multi-core debug allows multiple cores to be debugged in the same workspace and IDE
(Integrated Development Environment), often with a single hardware debugger.

» Integrated register viewer eliminates repetitive datasheet referencing with a graphical representation of
config registers used in the config tools.
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Flexibility

CodeFusion Studio also provides flexibility by consolidating technical information in a single data source, for
easy integration into custom tooling and modern automated workflows.

» SoC (System on Chip) Data Model provides detailed technical information, including the relationships

between config choices and registers, memory layouts, and pin multiplexing.

« This JSON-encoded data model is human and machine-readable, allowing engineers to build custom
tools.

« Command-Line First ensures critical actions run on the CLI enabling compatibility with modern Cl
pipelines, and better test, build, and deployment processes.

» Plugin-based code generation separates design decisions, captured in the config tools, from the code
generation engine, allowing users to tailor code to their own HALs, APlIs, or schedulers. (image 1)

Goals

CodeFusion Studio aims to bring embedded software into the modern, heterogeneous world. It enables
repeatable, testable, and maintainable development pipelines that customers fully own. It creates a window
into complex, opaque systems, offering a clearer view of resource allocation and system performance.
Above all, it aims to provide the flexibility engineers need to develop solutions that last as long as the
hardware it's built to support.
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Features

See all the features CodeFusion Studio has to offer.

Homepage

Homepage with quick access links for common tasks, links to articles and videos related to your projects,
user guides, hardware reference manuals, data sheets, and other useful resources.

Welcome to CodeFusion Studio /| Show at startup
Quick access Walkthrough

['f'_ Mew Project @

O Open Project Get started with the CodeFusion Studio VS Code extension

‘.a Open Config File Set up your environment and create your first project.

ﬁ’j Open ELF File

Resources you might find helpful

ANDG
DEVCES

nmmﬂﬁ

MAX78002

Smart Battery Backup for Uninterrupted Energy Developing Power-Optimized Applications on the
Part 1: Electrical and Mechanical Design MAX7B002
Link - analog.com Link - analog.com

. p
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http://localhost:8000/docs/codefusion-studio/user-guide/about/images/welcome-homepage-light.png#only-light
http://localhost:8000/docs/codefusion-studio/user-guide/about/images/welcome-homepage-light.png#only-light

Project wizard

A new project wizard for quickly creating projects as well as example applications to jump-start your
development.

Create a project

Ensure you have the details of the SoC at hand. Our project wizard
guides you through the steps to create your new project.

Project name

MyProject

Processor

. Search SOCs (8 available) b4

Board

Firmware Platform

Toolchain support

Toolchain support for building applications on Arm and RISC-V processors.

 MSDK projects use the Arm GNU toolchain and the xPack GNU RISK-V embedded GCC toolchain.

o Zephyr projects use the Zephyr SDK's Arm and RISC-V toolchains.

Configuration tools

Pin and clock configuration tools for assigning signals to pins, configuring pin values such as input or output
mode and power supply, viewing register details and values, and generating source code to be included in
your project.
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{ } Search by name or address

" B SELECT * FROM symbols ORDER BY ID ASC X M

=}
num name type address section size localstack stack  bind visibility path
0 NOTYPE 0x00000000 UND 0 LOCAL STV_DEFAULT
1 Jtext SECTION 0x10000000 @ text ) LOCAL STV_DEFAULT
2 bin_storage SECTION 0x10009C44 .bin_storage 0 LOCAL STV_DEFAULT
3 ARM.exidx SECTION 0x10009C44 ® .ARM.exidx 0 LOCAL STV_DEFAULT
4 .data SECTION 0x20000000 ® .data 0 LOCAL STV_DEFAULT
5 bss SECTION 0x2000072C ® .bss 0 LOCAL STV_DEFAULT
6 Jpal_nvm_db SECTION 0x10340000 .pal_nvm_db 0 LOCAL STV_DEFAULT
& .stack_dummy SECTION 0x20000F98 .stack_dummy 0 LOCAL STV_DEFAULT
8 ‘heap SECTION 0x20000F98 .heap 0 LOCAL STV_DEFAULT
9 .mailbox_0 SECTION 0x00000000 mailbox_0 0 LOCAL STV_DEFAULT
10 .mailbox_1 SECTION 0x00000000 .mailbox_1 0 LOCAL STV_DEFAULT
n ARM.attributes SECTION 0x00000000 ARM.attribu... 0 LOCAL STV_DEFAULT
12 .comment SECTION 0x00000000 .comment 0 LOCAL STV_DEFAULT
13 .debug_info SECTION 0x00000000 .debug_info 0 LOCAL STV_DEFAULT
14 .debug_abbrev SECTION 0x00000000 .debug_abbr... 0 LOCAL STV_DEFAULT
=] debug_loc SECTION 0x00000000 .debug_loc ) LOCAL STV_DEFAULT
18 .debug_aranges SECTION 0x00000000 .debug_aran... a LOCAL STV_DEFAULT
7 .debug_ranges SECTION 0x00000000 .debug_rang... ) LOCAL STV_DEFAULT
18 .debug_macro SECTION 0x00000000 .debug_macro a LOCAL STV_DEFAULT

« Browse through segments, sections, and symbols with the interactive memory map:
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Segments

Id Type Address Size  Flags Align
0x20000000 LOAD 389 kB 0 ARM_EXIDX 0x10009C44 8 R a
=3} 0x10009C44
1 LOAD 0x10000000 40,012 RX 4096
2 LOAD 0x20000000 3,988 RW 4096
0x10000000 LOAD 39.07 KB
Read [ Read 3 Seaments
Write only Unused

Debug

Debugging features including breakpoints, disassembly, heterogeneous debug, etc.

I-|—:’j RUM AND DEBUG | [ | CFS: Cortex Debug with GDB and ~ | & - € main.c
% VARIABLES CFS: Cortex Debug with GDE and OpenOCD (ARM Embedded)
p % WATCH CFS: Debug with GDE and CpenOCD {RISC-V)
“ CALL STACK

Mode,js...

CMake Debugger..
C++ (Windows)...
GDE and OpenOCD...

Add Configuration...

45
45

£

48

B R %

©
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Navigation

An overview of the CodeFusion Studio layout and navigation.

File  Edit  Selection View Go Run -+ 2 Search 0DB8 oo - ] *

CODEFUSION STUDIO CFS Home Page X a -

far Open Home Page
& walkthrough
v Projects Welcome to CodeFusion Studio /) show at startup
S [ New Project
o 3 Open Project
Browse Examples

E:? Quick access Walkthrough

~ Config Tocls

- .

1 Open Config File [3 Mew Project <)>
@ @ Config Tools Guide
(& Config Tools Walkthrough Get started with the CodeFusion Studio VS Code extension
@ ~ ELF File Explorer &Y Open Config File Set up your environment and create your first project.

Y Open ELF File

~ HOME 2
p ~ CFS Home Page

99 Open Project

{9 Open ELF File

ACTIONS
% Build 3 Resources you might find helpful
L Clean
hd @ Erase
W Erase (OpenOCD)
W Erase (JLink)
~ £ Flash
£ Flash (OpenOCD)

MAX78002

# Flash (ILink) - . Facial Recognition and Securi
~ &> Debug

&> Debug (Arm Cortex-M4, OpenOCD)

™ Deb - . ink Smart Battery Backup for Uninterrupted Energy Part Developing Power-Optimized Applications on the Visual Identification Al at Th
sgientoloniCoriagid g 1: Electrical and Mechanical Design MAX78002 Recognition
&> Debug [RISC-V, OpenOCD) Link - analog.com Link - analog.com Video - 1 minute
@ @ Debug with Ozone . b
~
L 5

n-:-u_.u w0

to the CodeFusion Studio homepage.

CFSicon: @

Access view and 3. Actions view.

e The 4. Support resources provides links to CodeFusion Studio support resources. See CodeFusion Studio
Support for more information.

« The 5. VS Code status bar provides access to project information.

@ Note

For more information on nagivating VS Code, see [] Visual Studio Code User Interface
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https://code.visualstudio.com/docs/getstarted/userinterface
https://code.visualstudio.com/docs/getstarted/userinterface
https://code.visualstudio.com/docs/getstarted/userinterface

Supported Processors

CodeFusion Studio currently supports the following processors in the following configurations:

Processor MSDK Zephyr Pin Config Clock Config
MAX32655 Yes - - -

MAX32662 Yes - - -

MAX32670 Yes - - -

MAX32672 Yes - - -

MAX32675 Yes - - -

MAX32690 Yes Yes Yes Yes
MAX78000 Yes - - -

MAX78002 Yes - Yes -
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https://www.analog.com/en/products/MAX32655.html
https://www.analog.com/en/products/MAX32662.html
https://www.analog.com/en/products/MAX32670.html
https://www.analog.com/en/products/MAX32672.html
https://www.analog.com/en/products/MAX32675.html
https://www.analog.com/en/products/MAX32690.html
https://www.analog.com/en/products/MAX78000.html
https://www.analog.com/en/products/MAX78002.html

Help

The following support resources are available:

Support type

Online
Documentation

GitHub

Engineer Zone

Technical Support

CFS Product Page

Details

Online documentation can be found on [§ developer.analog.com

CodeFusion Studio repository can be found on [J GitHub

(7 ADI Engineer Zone is an online community forum where you can search the

answered questions or ask one of your own.

To request technical support, submit this [ Online form

For downloads and documents related to CodeFusion Studio, visit [7 CodeFusion
Studio
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https://developer.analog.com/docs/codefusion-studio/1.0.0/
https://developer.analog.com/docs/codefusion-studio/1.0.0/
https://developer.analog.com/docs/codefusion-studio/1.0.0/
https://github.com/analogdevicesinc/codefusion-studio
https://github.com/analogdevicesinc/codefusion-studio
https://github.com/analogdevicesinc/codefusion-studio
https://ez.analog.com/
https://ez.analog.com/
https://ez.analog.com/
https://support.analog.com/en-US/technical-support/create-case-techsupport/
https://support.analog.com/en-US/technical-support/create-case-techsupport/
https://support.analog.com/en-US/technical-support/create-case-techsupport/
https://analog.com/CodeFusionStudio
https://analog.com/CodeFusionStudio
https://analog.com/CodeFusionStudio
https://analog.com/CodeFusionStudio

Installation
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Installation

This section provides instructions for installing and setting up CodeFusion Studio for supported processors.

o Software Requirements needed to install CodeFusion Studio

» Optional Install Segger J-Link Drivers
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Software requirements

Software dependencies

e Microsoft's Visual Studio Code version 1.89.0 or later.

Host OS support

CodeFusion Studio and extensions are supported on the following host operating systems:

« Windows 10 or 11 (64-bit)
e macOS (ARM64)
o Ubuntu 22.04 and later (64-bit)

Linux support

The CodeFusion Studio installer requires the following packages in order to run.

sudo apt install libfontconfigl libdbus-1-3 libxcb-icccm4 libxcb-image® libxcb-keysyms1 libxchb-
render-util® libxcb-shape@ libxcb-xinerama® libxkbcommon-x11-0 1libgl1

@ Note

These packages are included in default Ubuntu installations, but may need to be added to headless
installations.
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Installing CodeFusion Studio

CodeFusion Studio consists of two components, the SDK and the VS Code Extension.

Download

e [ Linux
e [4 macOS
e [J Windows

Install

@ Note

The Linux installer downloads without execute permissions. Run chmod a+x <installer> to grant execute
permissions before continuing. The CodeFusion Studio installer doesn't require elevated sudo permissions to

run.

1. Open the downloaded installer wizard to begin the installation process.

@ CodeFusion Studio Setup

Setup - CodeFusion Studio
Setup - CodeFusion Studio

Welcome to the CodeFusion Studio Setup.
Installation Folder
Select Components
License Agreement
Start Menu shortcuts

Ready to Install

Installing v

Next Quit
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https://download.analog.com/codefusion-studio/1.0.0/CodeFusionStudio_1.0.0.run
https://download.analog.com/codefusion-studio/1.0.0/CodeFusionStudio_1.0.0.run
https://download.analog.com/codefusion-studio/1.0.0/CodeFusionStudio_1.0.0.run
https://download.analog.com/codefusion-studio/1.0.0/CodeFusionStudio_1.0.0.dmg
https://download.analog.com/codefusion-studio/1.0.0/CodeFusionStudio_1.0.0.dmg
https://download.analog.com/codefusion-studio/1.0.0/CodeFusionStudio_1.0.0.dmg
https://download.analog.com/codefusion-studio/1.0.0/CodeFusionStudio_1.0.0.exe
https://download.analog.com/codefusion-studio/1.0.0/CodeFusionStudio_1.0.0.exe
https://download.analog.com/codefusion-studio/1.0.0/CodeFusionStudio_1.0.0.exe
http://localhost:8000/docs/codefusion-studio/user-guide/installation/images/installer-setup.png
http://localhost:8000/docs/codefusion-studio/user-guide/installation/images/installer-setup.png

. Click Next to continue the setup.

. Specify the folder destination for the install, and click Next.

. Select the Default or desired components to install, and click Next.

. Read the license agreement and click the box if you accept the license, then click Next.
. Select the Start Menu in which to create a shortcut, and click Next.

. Review setup selections and click Install.

0 N O o b~ W0 N

. Click Finish to close the installer.

Warning

Installation path cannot contain spaces.

Command line installation

Invoke the installer with the install switch to install the full package to the default location, with the
following switches:

Switch Effect

--help Provide help output

-t Specify the path to install to
-c Confirms prompts

--al Accept license

@ Note

If using the --al switch to accept the license, refer to the Licenses directory for the licence text and ensure
you agree with them before using CodeFusion Studio.

To run the installer headless, use the following:

CodeFusion_Studio_1.0.0 install -c --al
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Installing CodeFusion Studio extension

Install the [ CodeFusion Studio extension from the Visual Studio Code Marketplace.

Page 28 /138
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Set up CodeFusion Studio

missing or incorrect then you will be prompted to update it:

/\ The path to the CFS SDK is missing or not valid and this o3 X
prevented the extension from loading correctly. Please
download and install the CFS SDK, or set the path to the CFS
SDK through the CodeFusion Studio extension settings.

Source: CodeFusion Studio Download SDK Choose SDK path

appropriate path.

The installation path can also be manually configured under user settings by searching for cfs.sdk.path.
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Installing VS Code Extensions

@ Note

The VS Code extensions should be installed automatically as part of the installation process. This step is only

installer. To install the *.vsix file, open Visual Studio Code. From the Extensions tab, click Install from

VSIX... from the ellipses menu:

¥] File Edit Selection View - “
EXTEMSIONS

Search Extensions in Marketplace

7 v v O

~ |INSTALLED
Liviake
A CMake langage support for Visual Studio Code
twos
CMake Tools
AA Extended CMake support in Visual Studio Code

ﬂ' Microsoft

CodeFusion Studic

85
@ @ Build and Debug applications for Analog Devices targets

analogdevices

>— -
<> P Cortex-Debug

2 Untitled (Workspace)

- = Settings seftings.json
Views »
Check for Extension Updates

Disable Auto Update for All Extensions

Enable All Extensions
Disable all Installed Extensions
Show Running Extensions

Start Extension Bisect

B install from VSIX...
&

L 3ims

Filter {e.g. text, ™/™ts, !"*/node_modules/

Bla mraklamc howva hoan datartad in the

And browse to the desired *.vsix file(s) in your <codefusion-sdk-install>/VSCode directory.

e For the CodeFusion Studio IDE, select cfs-ide-*.vsix
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Install Olimex USB ARM JTAG Drivers for
RISC-V Debugging

Olimex drivers are not provided directly by CodeFusion Studio so need to be installed manually if RISC-V
debugging is required.

Download and installation instructions can be found in chapter 3 of the [J Olimex ARM-USB-OCD-h User

Manual

Linux configuration

On Linux the user may need to be added to the dialout group in order to use the Olimex Debugger.

sudo usermod -aG dialout <username>
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Install Segger J-Link debugger drivers

Segger's J-Link is a popular JTAG/SWD debugger supported by CodeFusion Studio. The J-Link drivers are
not provided directly by CodeFusion Studio so need to be installed manually if using a J-Link.

Download and installation instructions can be found on the Segger website at []

https://www.segger.com/downloads/jlink/
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Project Management
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Project management

How to create and manage projects in CodeFusion Studio.

How to Create a New Project
How to Open an existing project
How to Open and migrate an example

Additional CFS settings
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Create a new project

New projects are created with the New Project Wizard.

Launch the new project wizard

1. Click the CodeFusion Studio icon in the VS Code activity bar.

&

2. Click Home in the primary side bar.

3. Under Quick access, click New project to open the new project wizard.

Page 35/138


http://localhost:8000/docs/codefusion-studio/user-guide/about/images/cfs-icon-light.png#only-light
http://localhost:8000/docs/codefusion-studio/user-guide/about/images/cfs-icon-light.png#only-light

Create a project

Ensure you have the details of the SoC at hand. Qur project wizard guides
vou through the steps to create your new project.

Project name
MyProject

Processor

Q. Search S0Cs (8 available) =

Board

Firmware Platform

Template

&, Search Templates (0 available)

Project Location

Use default location

C/Example/cfs/1.0.0 Browse

Cancel

Create a project

1. Enter the project name.
2. Select desired processor from the dropdown menu. Type a partial name to filter.
3. For an ADI board, select the Standard option and then desired board from the dropdown menu.

4. For an custom board, select the Custom option and then provide your custom board file.
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. Select a template project from the dropdown menu. Type to filter.

. Use the default location or uncheck the box to choose a different location.

@ Note

The project location can be edited manually or a new project location can be set using the Browse button.

. Click Generate.

. CFS provides a notification to indicate the new project has been created. To open the new project, click

Open Project.

o S : :
\i) Project MyProject2 created successfully! 8 x

Source: CodeFusion Studio Open project
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Open an existing project

If the project contains a *.code-workspace file this should be opened directly rather than opening the

project's root directory.

@ Note

On some systems, files starting with . are hidden by default.

1. Click on File then Open Workspace from File....

2. Navigate to and open the *.code-workspace file.

If the project doesn't contain a *.code-workspace file the workspace directory can be opened using the

following steps.

1. Click the CodeFusion Studio icon in the VS Code activity bar.

&

2. Click Home in the primary side bar.

3. Under Quick access, click Open Project to open the file explorer.
4. Select the desired project and click Open project.

5. After opening the project, the contents are displayed in the Explorer view in the primary side bar.

@ Note

If your existing project has not been configured as a CodeFusion Studio project, follow the notifications and
prompts that appear after opening the project to configure the workspace and migrate the project to CFS.
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main.c

Makefile

project.mk

README.md
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Open and migrate example

The MSDK contains examples for each microcontroller that demonstrate the usage of peripheral APIs and
other supported libraries. These examples are provided as reference.

Duplicate the Example Folder

Warning

We strongly recommend copying the example projects before modifying any files to preserve the original

examples.

1. Open a file explorer.

3. Copy the Examples folder to the desired location.

4. You can now open an example project in a single folder workspace or a multi folder workspace.

Openin a single folder workspace

2. Click on the Explorer icon in the VS Code activity bar.
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3. Click the Open Folder button.

¥J File Edit Selection View Go

EXPLORER

~ MO FOLDER OPEMNED

You have not yet opened a folder.

You can clone a repository locally.

Clone Repository

(.
Jo
z_r; Open Folder
&
B

To learn more about how to use Git and
source control in VS Code read our docs.

You can also open a Java project folder,
or create a new Java project by clicking
@ the button below.

Create Java Project

®

4. Navigate to the location where you saved the example projects.

5. Select the example project to open, and click Add.

H Tip

If you receive the notification Do you trust the authors of the files in this folder?, check the box labeled
Trust the authors and click Yes, | trust the authors.

6. If the project needs to be migrated to a CodeFusion Studio Project, a notification prompt will appear
asking you to migrate.
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7. Confirm the project has been migrated by expanding the .vscode folder and verifying the backup folder
~ RW_ARM_Loader
» .settings
~ vscode
C_Cpp_properties json
flash.gdb
launch.json
i README.md
settings,json

2. Click on the Explorer icon in the VS Code activity bar.

3. Click the Open Folder button.

] File Edit Selection View Go

‘ @ EXPLORER

» NO FOLDER OPENED

/O You have not yet opened a folder.

Open Folder

01—63

You can clone a repository locally.

Clone Repository

O
B:! To learn more about how to use Git and
source contral in VS Code read our docs,

You can also open a Java project folder,
or create a new Java project by clicking
@ the button below.

Create Java Project

®@

4. Navigate to the location where you saved the examples.

5. Select two example projects to open, and click Add.
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Warning

You must select two distinct projects, each containing a makefile at the highest level in their respective

folder structure.

’qud Folder to Workspace
« v 1

Organize - New folder

s Quick access

« Windows (C;) » workdir » temp ? dualCore

Name

Dual_core_sync_arm

v O Search dualCore

Date modified Type

4/2/2024 4:43 PM File folder

# OneDrive - Analog De

Dual_core_sync_riscv 4/2/2024 4:43 PM File folder

v W This PC
3 3D Objects
om Desktop
o= Documents
4 Downloads
D Music
o= Pictures
B Videos
> 3 Windows (C)

¥ Network

Folder: | "Dual_core_sync_arm" "Dual_core_sync_riscv"

Add

Cancel

6. If the project needs to be migrated to a CodeFusion Studio Project, a notification prompt will appear
asking you to migrate. Click Migrate to continue.

7. Confirm the project has been migrated by expanding the .vscode folder and verifying the backup folder
~ BN_ARM_Loader

» settings

~ wscode
C_cpp_properties.jsan
flash.gdb
launch.json

@ READMEmd

settings.json

containing MSDK settings is present.
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Workspace, or Folder level depending on the number of projects within a configured workspace, and are

used hierarchically: Folder > Workspace > User .

o User settings can be modified from the File > Preferences > Settings menu.

» Workspace settings can be modified from the File > Preferences > Settings menu or by editing the

.vscode/settings.json in your workspace.

» Folder settings can be modified by editing the .vscode/settings.json in your sub directory. Workspace

settings are created when a project is created and will have values related to that project. User settings

have the default values below:

ID

cfs.cmsis.pack

cfs.cmsis.root

cfs.cmsis.svdFile

cfs.configureWorkspace

cfs.debugger.SWD

cfs.debugPath

Description

Absolute path to

Path to the root
CMSIS pack

directory

Absolute path to
the .svd file.

Whether this
workspace
should be
configured as an
CodeFusion IDE
project.

Select the
debugger to use.

Path to the
directory
containing the
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User Default Value

null

${userHome}/AppData/Local/Analog/Packs

No

MAX32625PICO

null




cfs.openocd.interface

cfs.openocd.riscvinterface

cfs.openocd.path

cfs.openocd.target

cfs.openocd.riscvTarget

cfs.programFile

cfs.riscvProgramFile

cfs.project.board

cfs.project.name

cfs.project.target

Description

Absolute path to
the OpenOCD

interface script

Absolute path to
the OpenOCD

interface script
for RISCV core

Path to openocd

Absolute path to
the OpenOCD

target / board
script

Absolute path to
the OpenOCD

target / board
script for RISCV
core

Target Board
Support Package

Project name

Target processor

Page 45 /138

User Default Value

null

null

null

null

null

null

EvKit_V1

${workspaceFolderBasename}

MAX78000




ID

cfs.sdk.path

cfs.toolchain.armAArch32GCC.path

cfs.toolchain.riscVGCC.path

cfs.toolchain.selectedToolchain

cfs.openHomePageAtStartup

Description

Absolute path to
your CodeFusion

Path to the arm-
none-eabi GCC

toolchain

Path to the RISCV

The toolchain to
build the current
project with

Launch the CFS

home page when
a CFS project is

User Default Value

null

${config:cfs.sdk.path}/Tools/gcc/arm-
none-eabi

${config:cfs.sdk.path}/Tools/gcc/riscv-

none-elf

arm-none-eabi

Yes
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Tasks to build, clean, flash and debug

After creating a project and configuring the workspace, you can run various tasks to create, flash, clean, and
run applications.

Access the tasks

Tasks can be accessed in the following ways:

» Open the Terminal menu and select run build task, and select the task.

e Open the command palette and enter the task name.

« Click on the CodeFusion Studio icon on the activity bar and then select a task from the Actions view (3 in
the diagram below).

e Click on the icon in the left side of the status bar (5 in the diagram below).

o Select the desired build task:

File Edit Selection View Go Run - ) Search

CODEFUSION STUDIO CF5 Home Page X

<

@ s HOME

- 2
¥

v CFS Home Page
i} Open Home Page
® walkthrough
~ Projects Welcome to CodeFusion Studio /] show at startup
> [% New Project
o 3 Open Project

Browse Examples .
E:? : Quick access Walkthrough
~ Config Tools

3 Open Config File [ New Project <)>
@ ® Config Tools Guide

(® Config Tools Walkthrough Get started with the CodeFusion Studio VS Code extension
@ ~ ELF File Explorer dD Open Config File Set up your environment and create your first project.
19 Open ELF File

99 Open Project

4 Open ELF File

ACTIONS
% Build 3 Resources you might find helpful
A Clean -
~ Til Erase i L Qo \f
W Erase (OpenOCD) ) " .
MW Erase (Link) = ""T)‘I_TBUUE <F g HMDEVEES
~ £ Flash : : s : : MAX78002
£ Flash (OpenOCD) E "y !
& Flash (JLink)
~ &> Debug

[ L T—
and sacurty g
inteligent vage

Facial Recognition and Secur
P ———

&> Debug (Arm Cortex-M4, OpenOCD)

™ Debug (Arm Cortex-M4. JLink Smart Battery Backup for Uninterrupted Energy Part Developing Power-Optimized Applications on the Visual Identification Al at Th
(= PR (I Y k) 1: Electrical and Mechanical Design MAX78002 Recognition
&> Debug (RISC-V, Open0OCD) Link - analog.com Link - analog.com Video - 1 minute

@ b Debug with Ozone ™ b
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@ Note

All tasks operate in the same way independent of the mechanism used to invoke them.

Tasks

CFS: build

line based on the project's settings.json file. It creates the ./build directory, which contains the output
binary and all intermediary object files.

The build configuration variables used by the makefiles are set during project creation or in the workspace,
user or system settings.

@ Note

Shortcut: ctrl + sShift + B (Windows/Linux) or Command + Shift + B (Mac).
The build task is also available with shortcuts on the left-hand side of the status bar.

L] g & ®oAo Wo

CFS: clean

@ Note

The clean task is available with the shortcut on the left-hand side of the status bar.

Bl [l ¢ & ®cao0 %o

CFS: clean-periph
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CFS: flash

connection. This halts the flashed program until the microcontroller is reset, power cycled, or a debugger is
connected. A debugger must be connected correctly to use this task. Refer to the data sheet of your
microcontroller's evaluation board for instructions.

@ Note

The flash task is available with the shortcut on the left-hand side of the status bar.

% @ [ & ®oho Wo

CFS: flash and run

complete.

CFS: erase flash

task, the target microcontroller is effectively blank. This is useful for recovering from low power (LP)
lockouts, bad firmware, or other issues.

CFS: debug

before debugging.

Using the activity view you can select a debug session to launch. See Debugging an application for more
information.
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@ Note

The clean task is available with the shortcut on the left-hand side of the status bar.

Bl x o s [E ®oac wo

Modify build tasks

To modify the default build and flash tasks, click the Terminal menu and select Configure Tasks.... Select
the task you wish to modify. A copy of the task will be added to your project's .vscode/tasks.json file,
where it can be adjusted to suit your application's needs.

For information on modifying build tasks, see [ https://code.visualstudio.com/docs/editor/tasks#_custom-

tasks
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CFS Terminal

provides additional paths for CodeFusion Studio without needing any additional user configuration. The
underlying shell depends on your host operating system:

e cmd on Windows
e zsh on Mac

e bash on Linux

Launch new terminal

To launch a new CFS Terminal, click the Terminal menu and select New Terminal. You can also select the

CFS Terminal

Split Terminal >

Configure Terminal Settings

Select Default Profile

Run Task...

Configure Tasks...

Clear the terminal

Click on the Views and More Actions... menu (...) in the top right corner of the terminal window and select
Clear Terminal.

Copy and Paste in the terminal
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To copy text from the terminal, select the text, and right-clicking on the selected text. Keyboard shortcut:
CONTROL+C (COMMAND+C on Mac).

To paste text to the terminal, right-clicking in the desired location. Keyboard shortcut CONTROL+V
(COMMAND+C on Mac).
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Zephyr RTOS projects

Modify west commands

CodeFusion Studio generates a default west build command for your current project (ex.: west build -b
apard32690/max32690/m4 ).

While the default west build command covers most common build cases, there are situations where you
need to pass additional parameters to west.

Examples of common cases where you want to alter the west build command include:

o Setting one-off KConfig parameters that you only want to use for one build: -DCONFIG_FAULT_DUMP=1
» Associating an optional config overlay file with your build: -DOVERLAY_CONFIG=my-overlay.conf

o Specifying a 'shield' to use with your development board: -DSHIELD=shield_name
There are two main ways you can customize the west build command in CodeFusion Studio:

1. Modify the task associated with the 'build' action.

2. Manually enter a west command using The CFS Terminal.

Example one

To perform a west build with additional OVERLAY_CONFIG parameters, tell the build system to include this
config file in the build operation by passing the parameters on the CFS terminal as follows:

west build -p auto -b apard32696/max32690/m4 -- -DOVERLAY_CONFIG=my-overlay.conf

Example two

To debug an application and receive more details when hitting a fault handler, do a one-off build with the
CONFIG_FAULT_DUMP KConfig flag set:

west build -p auto -b apard32690/max32696/m4 -- -DCONFIG_FAULT_DUMP=1
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@ Note

The double dash -- inthe west command line will pass any following arguments directly to CMake.

Add compiler arguments

To pass specific compiler switches to the build system, use zephyr_cc_option in CMakelLists.txt:

zephyr_cc_option(-fstack-usage)
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Troubleshooting

Build flags

» Having build flags set in environment variables may cause unpredictable build behavior.
If you are seeing flags that appear to be set incorrectly in your projects then check that there are no
environment variables set which may be overriding them.
Examples of such variables are AS, ASFLAGS, CC, CFLAGS, CXX, CXXFLAGS, CPPFLAGS, LD, LDLIBS,
LDFLAGS.

@ Note

A list of environment variables can be produced by running set on Windows, or env on Linux or Mac.
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Debugging
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Debugging

This section provides information on debugging in CodeFusion Studio.

« How to Debug an application

» How to Debug a Multi core application
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Debug an application

A default debug configuration is automatically generated with each new project. To manually create or adjust
a debug configuration, refer to the Create New Debug Configuration and Modify an Existing Debug
Configuration sections below.

Warning

Make sure you have a successful build for the core you intend to debug. Each project generates a build

Supported microcontrollers

See Supported processors for a full list of supported processors.

If debugging a single Arm core application, continue with these instructions. For debugging multiple cores
together, follow the Debugging a multi core application instructions.

Settings

Debug configuration settings are automatically selected using your CFS workspace settings. Follow the
extension prompts for any undefined settings. Adjust settings manually under the File > Preferences >

Settings menu.

When using the CFS: Debug with GDB and OpenOCD (ARM Embedded) configuration, CFS automatically

selected manually when prompted.

For more information regarding these settings, refer to CFS Settings.

Activate single debug session

3. Click on the Start Debugging Icon to the left of your selection (green play icon) or press F5.
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@ RUM AND DEBUG | D> | CFS: Cortex Debug with GDB and | & - C main.c

> VARIABLES CF5: Cortex Diebug with GDB and OpenOCD (ARM Embedded)
/O % WATCH CFS: Debug with GDB and OpenCCD (RISC-V)
~ CALL STACK
Node,js...
E} CMake Debugger...
C++ (Windows)...
ﬁl\’b’ GDE and OpenOCD..,

Add Configuration...

E:Il:l 45

46

& M

H Tip

To activate the previously utilized debug configuration, click the CFS:Debug icon on the left status bar.

Create new debug configuration

New debug configurations can be created using the following steps:

1. Click the Run tab, and select Add Configuration...

2. Select the appropriate debugger.

H Tip

3. Select the debug configuration template matching your target:

Supported Targets Type

Cortex-M (CMSIS) CFS: Debug with GDB and OpenOCD (ARM Embedded)
Cortex-M (CMSIS) CFS: Debug with JlinkGDBServer and JLink (ARM Embedded)
RISC-V CFS: Debug with GDB and OpenOCD (RISC-V)
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4. Save the launch.json file which now contains the chosen debug configuration.

Modify an existing debug configuration

Use the following steps too modify an existing debug configuration:

1. Openthe .vscode/launch.json file.
2. Click the Run tab, and select Open Configuration.

3. Make any necessary edits and save the file.

Run Terminal Help L
Start Debugging F5
Run Without Debugging Ctrl+F5
Stop Debugging Shift+Fs
Restart Debugging Cirl+Shift+F5

Open Configurations

Add Configuration...

Debugging interface

Debugging in VS Code is done using the Run and Debug View, available in the Activity Bar or under View >

Open View and selecting Run and Debug.

Controls

When connected to a debug session, the Run and Debug view provides a toolbar to control the application
execution. This debugging toolbar contains the following debugging actions:

29I Y T O 0O~

Name Action

Reset Performs a stop and reload
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Name Action

Pause Suspends execution to allow debugging

Step Over Steps to the next line, stepping over any function calls

Step Into Steps into any callee functions

Step Out Steps out of the current function to the calling function

Restart Resets the PC to reset address without disconnecting or reloading

Stop Terminates execution and closes the debug session
Variables

The variables view presents all of the variables visible to the current scope and file of debugging. They are
split into different sections for each of use, detailed below. Double clicking on a value allows you to edit the
value, right clicking provides a menu of additional options.

Local

~ VARIABLES

~ Local

268442731

Local variables are the variables in the current function scope.

Global
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Global variables are the variables in the global scope, visible to anywhere in the application.
~ VARIABLES = Ox
» Local

- Global |

_ctype_ = {<text variable, no ..
_impure_data
_dimpure_ptr

» Consolelart = 8x40844820

errmo

Static

Static variables are shown for the current file being viewed from the current PC or call stack selection.
~ VARIABLES = Ox

» Local

* Global

~ Static: ../main.c |

static a =1

static b = 2

» Registers

Registers

Registers provides a list of all of the core (non-memory-mapped) registers.
“+ VARIABLES
» Local
» Global
» Static: ../main.c
~ Registers
ré = 1873774592
rl = 6676
r2 = 1873798976
r3 = 268470956

Watch

Allows you to set expressions which are evaluated. These can be simple variables or complex statements.
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Warning

Expressions aren't context aware, so viewing a local variable from another context will fail to evaluate.
Expressions can set variable values, which will happen each time the expression is evaluated (on step or
pause).

Call stack

Displays the current call stack, with function name, PC address and source information where known.
Selecting a function in the call stack will show the registers and local variables applicable to that function.

~ CALL STACK Paused on step [P
MXC_GPIO OutClr@exleeeaf2c ci\analo '

L

LED_‘:lﬂ@E‘Kl@@EM?S T ;|'~;|: 1 ;:5 1.0.0/SDK/MAX

main@éxlBaeE2as main.c (54

Breakpoints

The breakpoints view allows you to see currently set breakpoints, toggle them on/off, and add new
breakpoints. To add a new breakpoint, click on the + icon in the breakpoints view, click in the gutter of the
source line, or right click on a source file and select Add inline breakpoint or click SHIFT + F9. Right-click on
a breakpoint to view a list of operations that can be performed on the selected breakpoint and all breakpoints
in general.
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#714

RUM AND DEBUG | [>| CFS: Cortex Debug with GDB and OpenQOCD (ARl | 83 - C main.c X CFS Home Page t® @Y T O 0O

» VARIABLES C main.c > & main{void)
=g ¥ runcCeLiuis
> WATCH a1
» CALLSTACK Paused on breskpoint 42 [ Rk ROk KRR R R R R ROk R o R KK KR
“~ BREAKPOINTS 43 int main(void)
® M mainc 50 44 {
® [ mainc 54 45 int count = 8;
» CORTEX LIVE WATCH 46
437 printf({"Hello World!\wn");
» KPERIPHERALS
48
49 while (1) {
e 5o LED_On{LED_RED);
51 MXC_Delay(S@eeee);
52 LED_Off(LED_RED);
53 MXC_Delay(5@0008);
= 54 printf("count = %d\n", count++);
55 }
g6 1
57

To make a breakpoint conditional; right click on the breakpoint and select Edit breakpoint... then selected
Expression from the drop-down and enter your expression in the text field.

") 54 . printf("count = Zd\n", count+t);

Expression ~ | count == 18

Peripheral registers

The XPeripherals view provides a nested structure of peripheral registers and user-modifiable bits. Hover
over a register or bit to view more information, copy the value to the clipboard or modify the value.

Warning

Some bits are reserved and not provided in the list. Care should be taken when writing to an entire register that
any reserved bits are not set.

Memory

The Memory tab in the toolbar above the terminal shows the working memory. This displays a detailed image
of what is currently being stored in memory as the program executes.
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Customizing the memory view

To view a specific region of memory, click on the + icon and enter a memory address.

To customize that memory view, click on the pencil icon which will allow you to change the address, display
name, width and endianness:

Address: Hex/decimal constant or expression
O 10000000

Display Mame
O 10000000

Format = 4-Byte ~ Endianness | Little e

Apply To: This View v Cancel

Disassembly view

1. Right-click on the main program being executed in the Call Stack view and select Open Disassembly
View to view details of the machine-level instructions generated by the source code during a debugging
session.

@ Note

Stepping while this view is in focus performs a single assembly instruction step.
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C muain.c 1 Disassembly

Bx1888828a <frame_dummy+34> ae1e asrs  r@, r@, #32
46:
47: printf{"Hello World!\n"});
8x1888828C <main+ds fabs push {r3, rd, r5, r6, r7, 1r}
8x1688828e <main+2> 8c4s ldr re, [pc, #48] @ (ex1e8882cH <main+52>)
48: while (1) {
56: LED_On(LED_RED);
51: MXC_Delay(500000);
8xle8e8298 <main+d> acad ldr r5, [pc, #48] @ (ex1e8e82cd <main+56>)
52: LED_OFff(LED_RED);
53: MXC_Delay(506000);
54: printf("count = ¥d\n", count++);
8x16888292 <main+6> adaf ldr r7, [pc, #52] @ (@x1e8882c8& <main+60>)
a47: printf{"Hello World!\n"};
[»Bx168e8294 <main+8> g1fedafc bl 8x18881b2c <puts>
45: int count = @;
Bx1888a298 <main+l2s ae24 movs rd, #8
48:
49 while (1) {
5a: LED_on{LED_RED);
BxlBeea2oa <main+lds ae2a movs rg, #8
Bx1888829c <main+l6> g8feeafs bl axlaeeed74 <LED_On>
5e: LED_On{LED_RED);
51: MXC_Delay(560008);
Bxleoealad <main+2@s 2846 mowv rg, rs
Bx188e82a2 <main+22> gefefdfa bl 2x188888a08 <MXC_Delay>

Serial output

Minicom

Minicom is a command line utility for serial port communication on Unix platforms.

@ Note

You will need minicom if not already installed.

1. Run the following from a terminal:
$ minicom -D /dev/tty.usbxxx -b 115200

where /dev/tty.usbxxx matches your serial device.
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§ Example
When using the example "Hello World" program, the output looks like this:

Welcome to minicom 2.9

OPTIONS:

Compiled on Sep 22 2023, 21:10:41.
Port /dev/tty.usbmodem21362, 10:07:03

Press Meta-Z for help on special keys

Hello World!

count = @
count = 1
count = 2
count = 3
count = 4
count = 5

PuTTY

PuTTY is an open source SSH and telnet client for Windows.

@ Note

You will need PUTTY if not already installed.

1. In the Session category, select Serial as the Connection type.

2. Set the Serial line to the correct COM port for your device. Use the Windows Device Manager to find
your device under Ports (COM & LPT).

3. Set the Speed (baud rate) to 115200.

4. Click Open to start the serial terminal.
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ﬁ PuTTY Cenfiguration

Categony:
= Sfa-ssinn Basic options for your PUTTY session
{ + Logging Specify the destination you wart to connect to
= Terminal o
. Keyboard Serial line Speed
Bl [com?] | 115200
- Features Connection type:
& Window (OS5H @ Seisl (O Other: | Telnet
- Appearance
- Behaviour Load, save or delete a stored session
- Translation Saved Sessions
[#- Selection |
- Colours
=) Connection Default Settings Load
- Data
- Pray Save
- S5H
- Serial — -
- Telnet
- Rlogin
- SUPDOUP Close window on exit:
(O Aways  (JNever (8 Only on clean exit
About Cpen Cancel
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§ Example

When using the example "Hello World" program, the output looks like this:

COMT - PuTTY - O %

4
5

VS Code Serial Monitor

Warning

Arm CMSIS-DAP debuggers, including the MAXPICO and MAX32xxxx onboard debuggers, use the serial Break
to trigger a target reset. Microsoft's Serial Monitor in VS Code sends the Break before connecting to the serial
port, which will reset the processor when using these debuggers. JLink debuggers do not experience this
behavior. It is recommended to connect to the serial port before starting a debug session, or use an external

serial terminal like Minicom or PuTTY.

Note

You will need the Serial Monitor extension for VS Code if not already installed.

1. Click on Serial Monitor in the toolbar above the terminal.

2. Set the Monitor Mode to Serial.
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3. Set the Port to the port in use by the hardware.
4. Set the Baud rate to 115200

5. Click Start Monitoring. This prints the outputs associated with the source code.

© Info

To determine the correct port, view the available ports with the required port disconnected, connect the port
and see which value appears in the dropdown list

E Example

When using the example "Hello World" program, the output looks like this:

£

Maonitor Mode View Mode | Text ™~ | Port | COMS - USB Serial Port (COMS) ' O | Baudrate | 115200

Line ending | None Vv  EERBGIVOTGLGE = &7 @ EE

---- Opened the serizl port COMS ----

Hello World!
count = @
count = 1
count = 2
count = 3
count = 4
count = 5

Linux configuration

On Linux the user may need to be added to the dialout group in order to use your serial ports.

sudo usermod -aG dialout <username>

RTOS status

using the XRTOS tab.
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CUTPUT DEBUG COMSOLE TERMINAL PORTS MEMORY XRTOS SERIAL MOMITOR o~ X

RTOS Views: Session Name: "CFS: Cortex Debug with GDB and OpenOCD (ARM Embedded)”, Zephyr detected.

Thread Thread Thread Thread Stack Usage

Address Name Status Priori % (Used B / Size B)
Ty

Ox 20000040 idle RUNNING 15 - 15 % (48 / 328)

8x2ea8e1e0 main SUSPENDED for: 3816 ms a8 - 13 % (136 / 1824)

RTOS requirements

Some RTOSes may require changes in order to provide the debug information required by the XRTOS View.

For Zephyr, the following config flags must be enabled in your prj.conf file:

# Enable thread awareness when debugging
CONFIG_THREAD_NAME=y
CONFIG_DEBUG_THREAD_INFO=y
CONFIG_THREAD_ANALYZER=y

Other RTOSes will have their own required config flags. Please consult the relevant documentation for
configuration information.

@ Note
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Debug a multi core application

CodeFusion Studio provides debugging for supported microcontrollers with multiple cores.

The multi-core architecture of the MAX32xxx and MAX78xxx microcontrollers requires secondary images
contained within the image for the primary core. This means only a single image is required to boot and run a

mulit-core microcontroller.

The secondary core is enabled with a code sequence on the primary core. Debugging the secondary core is
available after MXC_SYS_RISCVRun() has been called on the primary core.

@ Note

Not all of the dual core evaluation boards have external debug ports for the secondary core. Care should be
taken when selecting a board to work with.

See Supported processors for a full list of supported processors.

RV_ARM_Loader example

The MAX78002 RV_ARM_Loader example is located within the CodeFusion Studio installation at <CodeFusion
Studio Install>/SDK/MAX/Examples/MAX786082/RV_ARM_Loader . This example uses the Arm processor to load
and prepare the RISC-V processor to run a chosen program.
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@ Note

By default, the example runs the MAX78802 Hello_World example on the RISC-V processor, found at

<CodeFusion Studio Install>/SDK/MAX/Examples/MAX78002/Hello_World . To run a different program on the
RISC-V processor, change the RISCV_APP variable in RV_ARM_LOADER/project.mk to point to the root directory of

the program to build and run:

project.mk

# This file can be used to set build configuration
variables. These variables are defined in a file called
# "Makefile" that is located next to this one.

H

# For instructions on how to use this system, see
# https://analogdevicesinc.github.io/msdk/USERGUIDE/#build-system

H Fhkkkkkhkhhkhhhhhrhhrhhrhdrhhdhhhrhhdrhhrrhrrhrhdrhdrhdrrdrdsx

# Enable the RISC-V loader
RISCV_LOAD = 1

# The RISCV application can be changed.
# It defaults to Hello_World
RISCV_APP=../Hello_World

Set up a workspace

Warning

Copy the example it into a new directory before modifying it so the original example can be restored.

1. Place the MAX78002 Hello_World example (or the example you'd like to run on the RISC-V processor) in

the same directory as the MAX78602 RV_ARM_Loader example.

@ Note

If the Hello_World project doesn't reside at ../Hello_World relative to RV_ARM_Loader or you want to use a
different project, you will need to update the project.mk within the RV_ARM_Loader example.

2. Click File > Open Folder to open the MAX78002 RV_ARM_Loader example in a single-folder workspace.

3. Click File > Add Folder to Workspace to add the MAX78082 Hello_World example to the workspace.
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@ Note

Convert the projects to CodeFusion Studio projects if required. See Open and Migrate Example for more
info.

4. Run the CFS: build to create the build directory which contains the ELF files for the Arm processor. These

files are used for the program file settings.
e build/RV_ARM_Loader.elf

e build/buildrv/riscv.elf

Debug settings

Embedded) debug configuration.
2. Select configuration/image files if prompted.

3. After the Arm debug session reaches the breakpoint in the main.c code, press Continue on the

configuration.

6. Select configuration/image files if prompted.

Control the session

The Call Stack can be used to navigate between each debug instance. This provides quick access to the
debugging taking place on each processor.
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Troubleshooting

Debugging

 Failure to select an option from the quick pick menu results in the debug session ending and an error
notification allowing allowing you another opportunity to set the required setting from a quick pick menu:

§ Example

CFS: programFile not selected. Please select a programfFile. E

Source: CodeFusion Studio (Extension) Choose Program File

§ Example

SVD file not selected. Please select an SVD file to use the €83

Cortex Peripherals Wiew.

Source: CodeFusion Studio Choose an SVD file

Serial monitor

 Failed to open serial port on Linux
The user may need to be added to the dialout group in order to manipulate the serial port.

sudo usermod -aG dialout <username>
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Tools

The following tools are available in CodeFusion Studio:

The Config Tool used to simplify configurations
The Pin Config used to configure pin multiplexing

The Clock config used to control clocks and related signals.
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Config Tool
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Config Tool

CodeFusion Studio (CFS) provides a combined configuration tool to allow easy configuration of pin and clock

settings. The Configuration Tool uses CFSCONFIG files which are generated using the New Project wizard.
Clicking on the appropriate .cfsconfig file in your project will open the Config Tool.

H Tip

See Create a new project or enter create project in the command palette to open the wizard.

Tool tabs

The Config Tool comprises of the following tabs.

Pin Mux

Configures the pin multiplexing. See Pin Config for details.

Function Config

Configures the function of enabled pins. See Pin Config for details.

Clock Confing

Configures the various clocks and divers. See Clock Config for details.

Registers

Displays all registers and corresponding values. The search bar provides filters for modified or unmodified
registers and allows filtering based on partial register names.

Click on the register name to view the register details.
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@ Note

Registers with an asterisk (*) indicate a value other than the default.

Generate Code

Generates the source files required to configure the pins in the application.

Warning

Any pin conflicts must be resolved in PinMUX before code can be generated.

1. Save the configuration file.
2. Select the export module in which the generated code will be run.
3. Click Generate code. This generates files containing the configuration code.

o The files created depend on the firmware platform used.

recommended filenames.

4. Save the generated files in the application with appropriate names.
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Pin Configuration

The Pin Configuration tool allows you to graphically manipulate the pin muxing and function within your
processor, removing the tedious and error prone elements from manual configuarion. The tool will flag up
any conflicting configurations and show you the available pins and functions for any peripheral.

The Pin Configuration consists of two screens within the Config Tool. For details on accessing the Config
Tool and using the output see Config Tool.

Pin Mux

The map of pins displays the current multiplexing configuration. This will update as peripherals are
configured and will show which pins are available, in use or any conflicts.

Hovering over a pin will provide a summary of what function the pin is and can be assigned to.
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Navigation
Hover over a pin to view available signal information. Nodes and lines on the diagram show as bold when
enabled and faint when disabled.

The diagram can be zoomed in/out using the scroll wheel of your mouse or by using the zoom icons in the

bottom right corner of the view. The fit to screen icon " resizes the diagram to the size of your window.

The diagram can be dragged around the window using the left/primary mouse button or equivalent
touchscreen gestures.

Filtering

The Search field will allow you to find any peripheral or pin by hame or number. Any hon-matching entries
will be hidden from view. To reset the view, click on the 'x' to the right of the search bar.

Peripherals

On the left of the view is a list of available peripherals. Expand a peripheral by clicking on the arrow on the
left to see all of the pins associated with that peripheral. When any peripheral is selected, all of the pins not
associated with that peripheral are hidden from the pin map.

Enable pins

Under the expanded peripheral is a list of signals containing the signal name and the pin designation.

Toggle the pin to 'on' @ to assign that signal to that pin. This enables the pin in the generated code and
updates the map.

When a pin is enabled, a configuration icon ! becomes available. Click on the configuration icon to
configure the functions associated with that pin.

Conflicts

Conflicts occur when multiple signals are configured to use the same pin and will cause operational errors.
Conflicting signals will be shown as red circle in the pin map, hover over that pin to see which peripheral
signals have been assigned.

A conflict is also shown in the signal list under a peripheral with a red X in a circle. ®
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To resolve a conflict, disable one of the functions associated with that pin.

Function Config

Displays a list of enabled signals and provides options to adjust the configuration of each. Each option has a
default value and can be adjusted with the drop-down menu of allowed options, or a free form text box.

GPIOO
@ PO.O

PO,

UARTO
<y ™

Select the signal name to view the options available.

Examples of options:

 Input or output mode

e Power supply

e Pull-up/pull-down

P0.0 Reset to default

Select Input or

Output Mode nput Mode W
Select Power

supply Use VDDIO ~
Select Pull- _ )
up/Pull-down | Disabled (Highl.. ~

On Zephyr projects, two additional fields are provided under function config:

o Device Tree identifier

o phandle identifier

@ Note

Use the Reset to default link to revert any changes.
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Clock Configuration

The Clock Configuration is a screen within the Config Tool. For details on accessing the Config Tool and
using the output see Config Tool.

Clock config diagram

This screen allows you configure the clock frequencies that are used by each of the peripherals and cores
on the processor. It includes error checking to ensure that the frequencies used are within the constraints of
the processor specification. After configuring your clock tree, you can generate code that will set the
hardware to the desired configuration.

This visual representation of the clock tree is similar to that found in the processor user guide. The diagram
contains nodes which represent the cores, peripherals, pins, multiplexers, and clock scalers present in the
processor. The frequencies used at each node are shown within the node.
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D PRESCALER

System Oscillator Prescaler

>

@ HEXIN M
L. wo  enP - In .
: put Frequency:
@® e o 120 MHz
- »
uuuuuuu H Output Frequency:
50 MHz
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Navigation

Hover over the lines or nodes in the diagram to view frequency and other information. Nodes and lines on the
diagram show as bold when enabled and faint when disabled.

Page 84 /138


http://localhost:8000/docs/codefusion-studio/user-guide/tools/config-tool/images/clock-config-light.png#only-light
http://localhost:8000/docs/codefusion-studio/user-guide/tools/config-tool/images/clock-config-light.png#only-light

The diagram can be zoomed in/out using the scroll wheel of your mouse or by using the zoom icons in the
bottom right corner of the view. The fit to screen icon " resizes the diagram to the size of your window.

The diagram can be dragged around the window using the left/primary mouse button or equivalent
touchscreen gestures.

Node types

In the left panel, the nodes from the diagram are listed, grouped by the type of the node:

o Core : A core on the processor.
» Divider : A frequency step-down scaler node.
» Multiplier : A frequency step-up scaler node

o Mux : A multiplexer that selects one of its inputs. In some cases, a mux can also direct a single input to
one of its outputs.

» Oscillator : An internal oscillator present in the processor.

» Peripheral : A peripheral of the processor that is fed by one of the clocks. A peripheral can often be
enabled or disabled.

o PinInput : A pin that can be attached to an external oscillator. To use a pin input you need to assign it
using the Pin Config tool.

e Pin Output : A pin that can send a clock out externally. To use a pin output you need to assign it using the
Pin Config tool.

Configuring clocks

Clicking on a node in the diagram or from the node list will show a view with the configuration options
relevant to that node:

< Back

PRESCALER

System Cscillator Prescaler

Select Divider Value

Divide by 2 ~
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Changing any of the configuration options will be reflected in the diagram.
Only valid options will be enabled by the tool.

Clicking back will take you back to the list.

@ Note

Some clock settings such as external input and output will require a corresponding pin to be configured via the
Pin Config tool before it can be enabled here.

Errors

Errors that cause nodes to display in red and indicate an error that needs to be resolved:

» A frequency out of range: The error indicates whether the frequency is above or below the limits of
operability of the peripheral.

» Unconfigured value: This error indicates a required setting has not been specified:
» Unspecified frequency at a pin input

e Pin mux is not set to direct the clock signal to the peripheral
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CFSUtil is an executable which provides a lot of the functionality within CodeFusion Studio and can be
invoked directly from the command line.

Accessing CFSUtil

From Windows command prompt, access CFSUtil with <CFS-Install>/Utils/cfsutil/bin/cfsutil.cmd .
From Linux, access CFSULtil with <CFS-Install>/Utils/cfsutil/bin/cfsutil.

@ Note

This page refers to cfsutil, but the commands used are the same regardless of method used.

Structure

CFSUtil contains a hierarchy of commands and sub-commands, each with their own parameters and help
menus.

Help

Passing --help at any level of the hierarchy shows the help information about that component.

§ Example

cfsutil --help provides top level help context. cfsutil elf --help provides help context for the elf
component. cfsutil elf info --help provides help context for the info generation of the elf component.
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Analyze

cfsutil elf analyze [file] [-j]

sizes.
Use the -j switch to produce output in JSON format.

Info

cfsutil elf info [FILEPATH] [-j] [-h] [-a] [-c] [-s] [-n] [--debug_segments] [--debug_sections] [--
debug_cu] [--debug_lt] [--debug_abbrevs] [--debug_syms] [--debug_dies] [--debug_heuristics] [-V]

The following switches can be used individually or in combination to select the required information.

Switch Information

-a Attributes

-c Core information about the ELF file
-h Header

-5 Size

If debug information is available, the following switches are also available.

Switch Information

--debug_abbrevs Contents of .debug_abbrev section
--debug_cu .debug_info for each compilation unit
--debug_dies Debugging Information Entry (DIE) tree
--debug_heuristics Heuristic information
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Switch Information

--debug_1t contents of .debug_line section
--debug_sections List of ELF sections
--debug_segments List of ELF segments
--debug_syms List of symbols

Additional options are available to control the output.

Switch Effect

-] Output in JSON format

-n Do not populate database

-v Verbose output
Memory

cfsutil elf memory [FILEPATH] [-s] [-t] [-y] [-i <value>] [-n <value>] [-j] [-d]

Available switches:

Switch Effect

-d Print detailed information

-i Display from sectment/segment with id

-s List of segments

-3 Output in JSON format

-n Display from sectment/segment with name
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Switch Effect

-t List of sections in each segment

-y List the symbols contain in each section

@ Note

For -t and -y, the sections/symbols to display can be restricted to a segment/section usinganid (-i) or a
name (-n).
For -y, the segment/symbols can be restricted to a segment/section using a name ( -n ).

Symbols

cfsutil elf symbols [FILEPATH] [SQLQUERY] [-j] [-f]

This command allows you to run SQL queries on the symbol table.
This involes queries on a table called symbols with the following fields.

Name Meaning

num Entry number

name Symbol hame

type The type associated with the symbol: None, Object, Function or Filename
address The start address of the symbol

section The section containing the symbol

size The size of the symbol

bind The binding type of the symbol: Weak, Local or Global

visibility The visibility of the symbol: Default or Hidden

Any valid SQL construct is supported here, including WHERE , ORDER, LIMIT, LIKE and REGEXP.Some
examples of queries are as follows.
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Filter Query examples

Specific colums SELECT name, address FROM symbols

Symbols larger than 100 SELECT * FROM symbols WHERE size > 100

bytes

Largest symbols SELECT * FROM symbols ORDER BY size DESC LIMIT 10

Symbols between addresses SELECT * from symbols WHERE address BETWEEN ©x18000000 AND
0x20000000

The output can be modified with the following switches.

Switch Effect
-f Print full path (if debug info is available)
-] Output in JSON format

Engines

Code is generated from config choices by means of a code generation 'engine'. There are a certain number
of engines included out of the box, and users can author and register additional engines on the command-
line.

The engines command enables you to interact with the list of available and registered code conversion
engines known to cfsutil.

List
cfsutil engines list [-v] [-f text]|json]

Lists the available export engines.

Use the -v switch for additional information on the engines.
Use the -f switch to specify the output format: either text (default) or json.
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Info

cfsutil engines info NAME [-f text|json]
Provides information about the named engine.

Use the -f switch to specify the output format: either text (default) or json.

SoCs

This data model is a JSON file that contains information on the package, available memory, config settings
and register details, and other essential information required to enable the graphical config tools and code
generation functionality.

The socs command allows you to interact with the SoC data models known to cfsutil.

List
cfsutil socs list

Provide a list of available SoC data models.

Export

cfsutil socs export -n <value> [-f json] [--gzip] [-i <value>] [-m] [-o0 stdio]

the rest are optional.

Switch Effect

-n=<name> The name of the SoC.[*1]

-i=<val> The number of spaces for JSON indentation (use "$\'t' for tabs). Default is 2 spaces.
-m Minify the JSON output.
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Switch Effect

--gzip Compress the output with gzip

@ Note

It is recommended to pipe the output to a file, especially if compressing the output:
cfsutil socs export -n=max32690-tqfn --gzip > file.gz

Generate

cfsutil generate -i <value> [-e <value>] [-o <value>] [-v] [-p] [-f text|json] [--force] [--1list] [-

-file <value>]

Generates source code from a .cfsconfig file. The -i <filename> switch is required, whilst the others are
optional. The following switches are available.

Switch Effect

-i=<file> The .cfsconfig file to generate from

-o=<directory> The output directory for generated code

-p Preview. Generate output to the console instead of a file
-f=<format> The format of the preview output (either text or json)
-v Generate verbose output

--force Overwrite existing files

--file=<file> Only generate the specified file

--list List the file(s) that will be generated
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@ Note

A list of SoCs can be generated with cfsutil socs list.
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ELF File Explorer

The ELF File Explorer enables users to quickly parse and analyze compiled binaries, reducing time spent on
debugging and profiling and providing deeper insights into the application structure.

Supported formats

and SO.

Open afile

Open from Activity bar

1. Select the CodeFusion Studio icon from the activity bar.

2. Select Open ELF File under ELF File Explorer.

3. Navigate to the ELF file you want to open.

Open from Explorer

Click on any ELF file in the explorer to view the contents of that file.

Navigation

Navigation icons are on the left of the page for: Statistics, Metadata, Symbols and Memory Layout. Help is
available via the help icon in the top right corner.

Statistics
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displayed in five sections.

statically linked | with debug_info | not stripped

FILE OVERVIEW
s ELF 32-bit | LSB | executable | ARM | UNIX - System V version 0
(=)

Main section sizes 40.89 KB total

33,496 ® text (37.02 KB)
25,122 .
® data (1.79 KB)
16,748
374 ® bss (2.07 KB)
Sections
Num Name
® text
Jbin_storage
3 ® ARM.exidx
4 ® dats
5 ® o5
6 pal_num_db

stack_dummy
heap

9 mailbox_0

File overview

Size

Functions

Variables

Symbol Types » Text

FUNCTIONS BY BINDING VARIABLES BY BINDING

Global Functions 207 Global Variables

Local Functions 14 Local Variables

Weak Functions 130

Largest Symbols @ Text
Name Section

_viprintf_r ® _viprintf_r
_vfiprintf_r ® _fiprintfr
_dtoa_r ® _dtoar
_HespBase _HeapBase
malloc_r ® _malloc_r

_malloc_av_ ® _malloc_av_

_realloc s ® reallocs

__sfvwrite_r ® _sfwrite_r

_udivmaddi4 ® _udivmoddid

MXC_GPIO_Config ® MXC_GPIO_Config

» Data Encoding: Indicates the endianness (little or big endian).

» File Type: Executable, relocatable, shared object, or core file.

» ABI Version: Application Binary Interface version.

» Debug Info: Indicates if the file contains debugging information.

o Stripping: Indicates if the file has been stripped of symbol information.

Main section sizes

o Text: Executable code.

» Data: Initialized global and static variables.

o Bss: Zero-initialized data, both explicitly zero and uninitialized data.
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Symbol types

Symbol types shows a count of functions and variables by binding: global, local, and weak. Filters are
provided above the table for all, text, data and bss.

Sections

The Sections table provides details on all the sections contained within the ELF.

Largest symbols

The Largest symbols table provides details on the 10 largest symbols in the ELF. Filters are provided above
the table for all, text, data and bss.

Metadata

The metadata page displays a summary of the sizes of each data type used (text, data and bss), and all of

layout, ELF version, contents, and flags.
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™

Main Section Sizes (40.89 KB)

0

® text (37.02 KB) @ data (1.79 KB)

Header Info

Class
ELF32

05 ABI
UNIX - System V

Machine
ARM

Program headers start
52 {bytes into file)

Header size
52 (bytas)

Section headers size
40 (bytes)

AEABI Attributes

File attribute

Tag_CPU_name

Tag_CPU_arch

Tag_CPU_arch_profile

Tag_THUMB_|SA_use

Tag_FP_arch

Tag_ABI_PCS_wchar_t

Tag_ABI_FP_denormal

Tag_ABI_FP_sxceptions

Tag_ABI_FP_number_model

Tag_ABI_align_nseded

Tag_ABl_enum_size

Tag_ABI_HardFP_use

Tag_CPU_unaligned_access

10,000 20,000

® bss (2.07 KB)

Data
2's complement, little endian

ABI Version
0

Version
0x00000001

Section headers start
541644 (bytes into file)

Program headers size
32 (bytes)

Mumber of section headers
26

Value

7TE-M

v7E-M

Microcontroller

Thumb-2

WFPv4-D16

Meeded

Meeded

|EEE 754

8-byte

small

SP only

vb
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30,000

Header Version

1 {current)

Type
EXEC (Executable file)

Entry point address
0x10000531

Flags
005000200, Version3 EABI, soft-float ABI

Number of program headers
3

Section header string table index
25

Heuristic Information

File attribute

Firmware Platform

Stack Size

Heap Size

ARM SRAM size

ARM Flash size

RISCV SRAM size

RISCV Flash size

Value

MSDK

4006 B

30728

1048576 B

34078728

0B

0B
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Header Info

The ELF file header contains metadata about the ELF file, including its type, architecture, entry point,

program headers, and section headers. This information is essential for the operating system to correctly
load and execute the file.

AEABI Attributes

about the binary, such as the target architecture, floating-point configuration, and optimization level. These
attributes ensure compatibility and optimize performance by conveying specific details about how the binary
was built, allowing tools and runtime environments to correctly interpret and execute the code.

Heuristic Information

Indicates the presence of any heuristic information detected in the ELF file related to the Zephyr and MSDK

firmware platforms. It can provide information regarding Flash and RAM sizes, among other available data.

Symbols Explorer

clicking the title of any column and can be filtered using an SQL query allowing you to access the data in any
way you require.

I;l B sELECT * FROM symbaols WHERE section LIKE '%text%’ ORDER BY size DESC X m Saved gueries
0
num name type address section size - bind visibility
1000 _viprintf_r FUNC 0x10002979 ® text 7,248 GLOBAL STV_DEFAULT
957 _vfiprintf_r FUNC 0x10004609 ® text 4,008 GLOBAL STV_DEFAULT
885 _dtoa_r FUNC 0x10006291 ® text 3,652 GLOBAL STV_DEFAULT
886 _malloc_r FUNC 0x100023ED ® text 1,396 GLOBAL STV_DEFAULT
733 _realloc_r FUNC 0x10007873 ® text 836 GLOBAL STV_DEFAULT

Page 99/138


http://localhost:8000/docs/codefusion-studio/user-guide/tools/images/elf-explorer-symbol-explorer-light.png#only-light
http://localhost:8000/docs/codefusion-studio/user-guide/tools/images/elf-explorer-symbol-explorer-light.png#only-light

The default view SELECT * includes the following fields. You can change which fields are shown and in what
order by replacing the * with a list of field names separated by a comma. For example SELECT size, name will
show the size column followed by name.

Column Type Description

num integer The unique number identifying the symbol

name string The name of the symbol

type string The type of the symbol, indicating what kind of entity it represents
address integer The memory address where the symbol is located

section string The section of the program in which the symbol is defined

size integer The size of the symbol in bytes

localstack integer The worst stack usage size for a function (only local stack, not considering

functions called)

stack integer The worst stack usage size for a function (considering functions called)
bind string The linkage type of the symbol (e.g., local, global)
visibility string The visibility of the symbol, indicating its accessibility from other modules

(e.g., default, hidden)

path string The source file location where the symbol is defined

@ Note

The localstack, stack and path columns are only present when the relevant data is present in the ELF. For

fdump-rtl-dfinish -fdump-ipa-cgraph -gdwarf-4. These switches are defined by default with CodeFusion
Studio projects.

Generating additional compiler data
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graph navigation), compile your code with the following flags: -fstack-usage -fdump-ipa-cgraph -gdwarf-4.

These flags will force the compiler to generate debug information using the DWARF-4 standard, which is the
version currently supported by the built-in DWARF parser.

Zephyr
For Zephyr Projects, add the following flags to CMakeLists.txt:

zephyr_cc_option(-fstack-usage)
zephyr_cc_option(-fdump-ipa-cgraph)
zephyr_cc_option(-gdwarf-4)

PROJ_CFLAGS += -fstack-usage
PROJ_CFLAGS += -fdump-ipa-cgraph
PROJ_CFLAGS += -gdwarf-4

@ Note

Stack usage and call graph data can only be parsed when generated by GCC.

Filters

The table can be filtered using SQL commands, where the table is named symbols and the fields are as
above.

H Tip

A quick lookup field is present above the table to search by name or address. Enter a text or numerical value
and press Enter to generate a query.

Queries
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Queries can be saved using the save icon to the right of the query field.

Click on the Saved queries button to the right of the query field to see a list of saved queries including some
pre-populated queries. Queries can be edited or deleted from here by clicking on the pencil or trash can
icons.

@ Note

Saved queries are stored in the user settings so they are available on any project.

Any valid SQL construct is supported here, including WHERE , ORDER, LIMIT, LIKE and REGEXP.Some
examples of queries are as follows.

Filter Query

Specific colums SELECT name, address FROM symbols

Symbols larger than 100 SELECT * FROM symbols WHERE size > 1080

bytes

Largest symbols SELECT * FROM symbols ORDER BY size DESC LIMIT 10

Symbols between addresses SELECT * from symbols WHERE address BETWEEN 0x10000000 AND
0x20000000

Symbols from a specific file SELECT * from symbols WHERE path LIKE %main.c%

Symbols starting with string SELECT * FROM symbols WHERE name REGEXP '*init\*'

Memory Layout

The Memory Layout page provides a visual representation of the memory map on the left, with a table of
memory segments on the right. The memory map is shared to denote the usage of the memory:

o Stripes: Unused memory.
» Blank: Read/write memory.

o Filled: Read only memory.
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@ Note

Overlapping segments are rendered as smaller rectangles to the right of the main segments. Small segments
may be displayed taller than their actual relative size to enhance readability. Refer to the size value for an
accurate size value.

Hovering over a segment in the memory map provides a summary of the memory segment and highlights the
appropriate table entry.

Hovering over a segment in the table highlights the approprate entry in the memory map.

Segments

The segments table shows a high-level summary of each distinct secment of memory.

N Segments
l J Id Type Address Size  Flags Align
HESesa] | LOAD s 1 0x10000000 37912 RX 4006
- 0x10009410 L2 * .
0
2 LOAD 0x20000000 3056 RW 4095
0 ARM EXIDX 0x10009410 8 R 4
0x10000000 LOAD 37.02 KB
LOAD
Read / Read
Write only START ADDRESS 0x10000000
END ADDRESS 0x10009418
SIZE 37912 bytes
The table includes the following fields:
Field Description
Id The unique identifier for the segment
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Field Description

Type The type of the segment, indicating its purpose (e.g., loadable, dynamic)
Address The memory address where the segment begins

Size The size of the segment in bytes

Flags Permissions and attributes for the segment (R: read, W: write, X: executable)
Align The alignment requirement of the segment in memory in bytes

Clicking on a segment will show you a table with the sections in that segment.

Sectionsina Segment

The Sections in a segment table shows a high-level summary of all the sections in that memory segement.

Segments Sections
[ J 0x10009410 -ARM.exidx 0 Num Name Address Size Flags Type
. text 0x10000000 37,904 AX PROGEITS
a8
3 ARM.exidx 010009410 8 A ARM EXIDX
0x10000000 .text 37.02 KB
Read / Read 2 Sections
Write only Unused

The Sections in a Segment table includes the following fields:
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Field

Description

Num The unique number identifying the section

Name The name of the section

Address The memory address where the section begins

Size The size of the section in bytes

Flags Permissions and attributes for the section described in the flags table
Type The type of the section, indicating its contents and purpose
Flag Description

W write

A alloc

X execute

M merge

S strings

I info

L link order

0 extra OS processing required

G group

T TLS

C compressed

X unknown
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Flag Description

o} OS specific

E exclude

D mbind

y purecode

p processor specific

Clicking on a section will show you a table containing the symbols in that section. To return to the Segments,
click on the Segments link in the breadcrumb at the top left of the page.

Symbols in a Section

The Symbols in a section table shows details for the symbols within that section.

Segments Sections Symbaols

About this section

LJ MNum Mame Address Size  Bind Visibility
Section Name ® text 1000 _viprintf_r 010002979 7.248 GLOBAL STV_DEFAULT
o
Section Type PROGEBITS a57 _vfiprintf_r 010004602 4008 GLOBAL STVW_DEFAULT
Starting Address 0x10000000 885 _dtoa_r 010006291 3,652 GLOBAL STV_DEFAULT
Ending Address 0x10009410 886 _malloc_r 0x100023ED 1,396 GLOBAL STV_DEFAULT
Size 3702 KB 733 _realloc_r 010007875 836 GLOBAL STV_DEFAULT
Is part of text 700 __sfvwrite_r 0100058940 768 GLOBAL STV_DEFAULT
Flags AX 704 __udivmoddid 0x100089F9 698 GLOBAL STV_HIDDEN
613 MXC_GPIC_Config 010000021 680 GLOBAL STV_DEFAULT
208 __aeabi_dsub 010008049 634 GLOBAL STV_HIDDEN
999 __subdf3 010008049 634 GLOBAL STV_HIDDEN
724 __adddf3 0x100080AD 630 GLOBAL STV_HIDDEN
772 __aeabi_dadd 0x100080AD 630 GLOBAL STV_HIDDEN
728 __aeabi_dmul 010008419 586 GLOBAL STV_HIDDEN
852 __muldf3 010008419 586 GLOBAL STV_HIDDEN
798 _freer 0x100021F1 508 GLOBAL STV_DEFAULT
723 __aeabi_ddiv 010008660 464 GLOBAL STV_HIDDEN
845 _ divdf3 0x1000866D 484 GLOBAL STV_HIDDEN

The Symbols in a section table includes the following fields:
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Field Description

Num The unique number identifying the symbol

Name The name of the symbol

Address The memory address where the symbol is located

Size The size of the symbol in bytes

Bind The linkage type of the symbol (for example: local, global)

Visibility The visibility of the symbol, indicating its accessibility from other modules (for example:

default, hidden)

To return to the Sections Segments, click on the appropriate link in the breadcrumb at the top left of the
page.
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Uninstall
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Uninstall CodeFusion Studio

Uninstall the extension from VS Code

2. Find the CodeFusion Studio extension in the INSTALLED list.
3. Click on the Manage (cog) icon on the right hand side.

4. Select Uninstall.

®] File Edit Selection View Go Run Terminal Help «—
@ EXTENSIONS [ oo = Settings seftings.json
/D Search Extensions in Marketplace W
» INSTALLED 25
Liviake
z-‘; A CMake langage support for Visual Studio Code
twxs & Welcome to Cod
ﬁr\‘\‘} CMake Tools
I‘;’p Extended CMake support in Visual Studio Code
‘ E:l? = @ Microsoft & Quick access
CodeFusion Studio "0 10%6ms D}- New Project
Gb @ Build and Debug applications for Analog Devices targets
analogdevices ] ¢J Open Project
@ Cortex-Debug 0]
@ ARM Cortex-M GDB Debugger support for WSCode
marus23
debug-tracker-vscode 0 Disable
A generic debug tracker that provides API/Event services for Disable (Workspace)
meu-debug
Auto Update
> Debugger for Java
'\._J} A lightweight Java debugger for Visual Studio Code 7
ﬂl‘ﬂicmsof‘t

Doxygen Documentation Generator e ]|
I o mmm s mbim s smaman ol mm e b b B 4 eme e e

@ Note

Keyboard shortcut to extensions is Control + SHIFT + X (Windows/Linux) or Command + SHIFT + X (Mac).
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Uninstall from file system on Windows

1. Navigate to the directory where CodeFusion Studio is installed.

2. Locate the MaintenanceTool.exe application and double click on it.

Name

ARM
installerResources
Licenses
OpenOCD
RISCV
SDK
Utils
VSCode
& components.xml
| InstallationLog.txt
| installer.dat
| MaintenanceTool.dat
@ MaintenanceTool.exe
& MaintenanceTool.ini
B make.exe
& network.xml

7w User Guide

3. After the MaintenanceTool.exe application launches, select Remove all components from the setup

menu.

Setup - CodeFusion Studio

Setup - CodeFusion Studio
Welcome to the CodeFusion Studio Setup.

Select Components
Add or remove components
License Agreement Update components
Ready to Uninsta ® Remove all components
| Uninstalling
Finisheg
Settings MNext Quit

4. Click Next to continue.
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5. Confirm that the correct directory is being removed and click Uninstall.

-

Ready to Uninstall

Setup - CedeFusion Studio
required information is now available to begin remaoving usion Studio from your computer.

All ired infi tion i ilable to begi ing CodeFusion Studio fi te

Select Companents mmm 1he program directory C:\analoglcfs1.0.0 will be deleted completely, including all content in that

directory!
License Agreement
Ready to Uninstall
Uninstalling

Finished

Uninstall || Cancel

6. CodeFusion Studio will now be uninstalled.

Uninstalling CodeFusion Studio

| 53

Setup - CedeFusion Studio

Select Components

License Agreement 3 of 62 operations rolled back.
Ready to Uninstall Show Details

Uninstalling

Finished

Uninstall Cancel
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7. After the uninstallation completes, you may close the installer by clicking Finish.

Completing the CodeFusion Studio Setup
Setup - CedeFusion Studio

Click Finish to exit the CodeFusion Studio Wizard.
Select Components
License Agreement
Ready to Uninstall

Uninstalling

Finished

Remove the file system on Linux or Mac

The CodeFusion Studio directory can be deleted directly from the filesystem without needing to run an
uninstall utility.
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Tutorials

« GNU Debugger (GDB) covering the basics of the GNU Debugger (GDB) and how to use it with CodeFusion

Studio.
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GDB Tutorial
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GDB Tutorial
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GDB Basics

The GNU Debugger (GDB) allows you to connect to and debug a wide variety of target devices.

It consists of a pair of command-line tools: a GDB server, and a GDB client. These two tools are used
together to locally or remotely analyze your program and asssembly code, and single step through the
program.

server with a GDB client, allowing you to interact with the target device.

Breakpoints

breakpoint command options to set rich conditions to cause a breakpoint. Setting rich conditions allows you
to debug very specific errors that only reproduce in given conditions.

Conditional breakpoints

Conditional breakpoints allow you to break on a specific line of code only if a certain condition is met. For
example, you can break on a line of code only if a variable is greater than a certain value.

Temporary breakpoints

Temporary breakpoints allow you to set a breakpoint that will only fire once and then delete itself.

Delete existing breakpoint

Recommendation is to delete breakpoints not in use as there are a limited number of hardware breakpoints
available.

Watchpoints
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Watchpoints are more powerful than breakpoints because they can evaluate a number of condidtions or
watch until a specific variable is accessed or changed. This gives you more control to look inside structures
or arrays of objects at specific times or debug memory access problems. The drawback is that they are
extremely slow as every instruction will be analyzed by the debugger when you set a watchpoint.

Stack Backtrace

Stack backtrace allows you to rollback the stack frames and see the progression of branches and execution
in the code. This helpes diagnose where you were before you ended up at the breakpoint or where you
stopped the program execution.

Info

Use the Info commands to get contextual information about the current state of the program such as
arguments passed into the function, the state of the core registers, or the current state of variables, local or
global.

Print

Use the print commands to display variables or manipulate variables. Can display arrays of data in a variety
of formats and perform calculations on specific variables or memory addresses. Works on C files.

Examine

Use the examine commands to show the address of a variable or the contents of memory. They can also
display instructions and format information. The examine commands have richer display capabilities than the
print commands and work on C files and assembly files.

Examine source code

The examine source code commands allow you to access the assembly source code of a function.
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Find

The find command allows you to scan a specific address range for a pattern or a known value. It allows you
to locate a specific instance, check stack space, or stack memory. Useful for checking the stack overflow or
watermark levels to know how much of your stack has been used.

Multiple image support

GDB normally parses one ELF file at a time, however, using the add-symbol-file command allows you to load

debugging a system with multiple cores or multiple images, allowing you to step accross boundries to
continue debugging.
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GDB Commands

commands have shortcuts that can be used to save time and keystrokes.

Navigation

Command Shortcut Description

ctrl+c N/A Halt the current program execution

continue c Resume execution

step S Step into the function

step [value] s10 Step the next 10 source lines

next n Run the next line in the function (step over)
next [value] n 10 Run the next 10 lines in current function

until [value] u20 Run until line 20 of the current file

finish f Run to the end of the function or stack frame

Breakpoints

Command Shortcut Description
break main b main Break on main () entry
break on function b main.c:func Break on function () in main.c
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Command

break on line

break on condition

break and delete

info breakpoints

ignore 2 20

disable 2

delete 2

Shortcut

b main.c:18

b main.c:18 if foo > 20

tbreak main

N/A

N/A

N/A

N/A

Description

Break on line 18 of main.c

Break if foo > 20 (boolean condition)

Fire once and deletes itself

Lists all breakpoints

Ignore breakpoint 2" for the first 20 times

Disable breakpoint 2’

Delete breakpoint 2!

Watchpoints

Command

watch foo

watch myarray[10].val

watch *Ox1000FEFE

watch foo if foo > 20

watch foo if foo + x > 20

info watchpoints

delete 2

Description

Watch foo

Watch .val in myarray[10]

Watch memory addr Ox1000FEFE

Conditional watch (foo >20)

Complex conditional expression

Lists all watchpoints

Delete watchpoint 2'

Stack Backtrace
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Command Shortcut Description

backtrace bt Display a stack backtrace (function call history)
frame Display the current stack frame

up Move up the stack

down Move down the stack

Info

Command Description

info locals List all local variables

info variables List all global variables
info args List all function arguments
info registers List all registers

info breakpoints List all breakpoints

info watchpoints List all watchpoints

Print

Command Shortcut Description
print p Print the value of a variable or expression
print variable p foo Print the value of foo
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Command

print multiple

print/hex ()

print/hex ()

print array ()

Shortcut

p foo+bar

p/x &main

p/x $rd

p/a (uint32_t[8])0x1234

Description

Print the complex expression of foo plus bar

Print the address of main()

Print the value of register r4 in hex

Print the array of 8 u32s at address 0x1234

Variables

Variable

Description

Address

Byte, 1B

Character

Decimal point

Float

Giant, 8B

Halfworld, 2B

Instruction

Octal integer

String

Binary integer

Unsigned decimal int
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Variable Description

w Word, 4B
X Hex integer
z Padded hex

Examine

FMT is a repeat count, followed by a format and size letter.

Command Shortcut Description

examine/[FMT] X Examine the count in format and size
examine variable x foo Show address of variabe foo

examine () x/4c Ox581F Show four characters at address 0x581F
examine () X/4xw &main Show four words in hex at main()

examine source code

Command Description

list Show scr for the current location

list x0x1234 Show source for address 0x1234

list main.C:func Show source for func() from main.C

disas func List ASM code for func()

find /b 0x0, 0x10000, 'H', 'e', 'I', 'I', '0' 0x581f search for a byte pattern between 0x0 to 0x10000
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Command Description

x/s 0x581f Examine string at address 0x581f

Find

Command Description

find Scan a specific address range for a pattern or known value

Multiple image support

Command Description

add-symbol-file Adds new ELF file into the same GDB session

1. Breakpoint and watchpoint numbers can be determined by viewing the $bpnum variable immediately after
creation. ¢ ¢ ¢« ¢
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Resources
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Resources

CodeFusion Studio supports a variety of tools, frameworks and APIs. Here are links to all of the currently
supported tools and integrations.

» Security
e SDKs

» Third party tools

The [J secure communication protocol bootloader can be used to generate images and communicate with
the bootloader.
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https://www.analog.com/media/en/technical-documentation/user-guides/ug7618.pdf
https://www.analog.com/media/en/technical-documentation/user-guides/ug7618.pdf
https://www.analog.com/media/en/technical-documentation/user-guides/ug7618.pdf

SDK resources

MAX78xxx Microcontrollers. This includes register and system startup files to enable low-level development
for its supported parts.

Zephyr

A small-footprint kernel designed for use on resource-constrained and embedded systems: from simple
embedded environmental sensors and LED wearables to sophisticated embedded controllers, smart
watches, and loT wireless applications.

(4 Zephyr 3.7.0 Documentation (Online) or [J Zephyr 3.7.0 Documentation (PDF)
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https://analogdevicesinc.github.io/msdk/USERGUIDE/
https://analogdevicesinc.github.io/msdk/USERGUIDE/
https://analogdevicesinc.github.io/msdk/USERGUIDE/
https://docs.zephyrproject.org/3.7.0/
https://docs.zephyrproject.org/3.7.0/
https://docs.zephyrproject.org/3.7.0/
https://docs.zephyrproject.org/3.7.0/zephyr.pdf
https://docs.zephyrproject.org/3.7.0/zephyr.pdf
https://docs.zephyrproject.org/3.7.0/zephyr.pdf

Trusted Edge Security Architecture

ADI's security for the Intelligent Edge is seamlessly bundled into CodeFusion Studio with Trusted Edge.

The Trusted Edge provides the foundational layer of security for the customer by melding industry standard
crpyto APIs with the security capabilities our hardware security solutions.

Features

Flexibility - Choose the crypto library that best fits your application. The Trusted Edge supports industry
standard crypto APIs.

Simplicity - Access hardware security capabilities of the complete ADI digital portfolio.

Reduced time-to-market - The Trusted Edge provides a secure foundation for your application, reducing the
time needed to implement security.

Installation

The security installer for CodeFusion Studio is distributed under a non-disclosure agreement (NDA) through
myAnalog.

1. Access analog.com.

2. Log in or sign up for a myAnalog account.

my~/\nalog Logln |Ssignup

3. After you log in, click Your Account.

4. Select Resources from the left navigation panel.
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https://www.analog.com/en/index.html
http://localhost:8000/docs/codefusion-studio/user-guide/resources/images/myanalog.png
http://localhost:8000/docs/codefusion-studio/user-guide/resources/images/myanalog.png

myAnalog

My Profile

Products

Orders

Projects

Resources

Parametric Searches

Subscriptions

Support

5. Select Software Downloads.

6. Click CodeFusion Studio Trusted Edge Security Architecture Installer.

Special Software Downloads

7. Check the box to indicate that you have read and agree to the software license agreement and click |
Accept.

CodeFusion Studio Trusted Edge Security Architecture Installer 1.0.0

Check here to indicate that you have read and agree to the software license agreement

8. Open the downloaded installer and follow the setup wizard to complete the installation.

Security Foundation Layer
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http://localhost:8000/docs/codefusion-studio/user-guide/resources/images/resources-nav.png
http://localhost:8000/docs/codefusion-studio/user-guide/resources/images/resources-nav.png
http://localhost:8000/docs/codefusion-studio/user-guide/resources/images/software-downloads.png
http://localhost:8000/docs/codefusion-studio/user-guide/resources/images/software-downloads.png
http://localhost:8000/docs/codefusion-studio/user-guide/resources/images/accept-license.png
http://localhost:8000/docs/codefusion-studio/user-guide/resources/images/accept-license.png

» Crypto library options
e mbedTLS
» wolfSSL
e PSA Crypto API
+ ADI USS API
» Root of Trust Services
« Unified Security Software
» Secure Storage
o Crypto Toolbox
» Secure Communication

» Universal Crypto Library

» Hardware Crypto Accelerators and Security Features

Supported boards

o APARD
MAX32690 EvKit

EVAL-ADIN1110

MAXQT065EVKIT

Unified Security Software

ADI Unified Security Software (USS) offers an APl backend that provides Secure Boot, Secure Channel,
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https://www.analog.com/en/resources/evaluation-hardware-and-software/evaluation-boards-kits/ad-apard32690-sl.html
https://www.analog.com/en/resources/evaluation-hardware-and-software/evaluation-boards-kits/max32690evkit.html
https://www.analog.com/en/resources/evaluation-hardware-and-software/evaluation-boards-kits/eval-adin1110.html
https://www.analog.com/en/resources/evaluation-hardware-and-software/evaluation-boards-kits/maxq1065evkit.html

Third party tools

Manual

Segger J-Link Debugger

Download and installation instructions can be found on the Segger website at [J
https://www.segger.com/downloads/jlink/

Page 132 /138


https://www.olimex.com/Products/ARM/JTAG/_resources/ARM-USB-OCD_and_OCD_H_manual.pdf
https://www.olimex.com/Products/ARM/JTAG/_resources/ARM-USB-OCD_and_OCD_H_manual.pdf
https://www.olimex.com/Products/ARM/JTAG/_resources/ARM-USB-OCD_and_OCD_H_manual.pdf
https://www.olimex.com/Products/ARM/JTAG/_resources/ARM-USB-OCD_and_OCD_H_manual.pdf
https://www.segger.com/downloads/jlink/
https://www.segger.com/downloads/jlink/
https://www.segger.com/downloads/jlink/
https://www.segger.com/downloads/jlink/

Release Notes
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Release Notes

¢ 1.0.0 Release Notes

See Help for details on how to get support with CodeFusion Studio.
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1.0.0 Release Notes

Source

CodeFusion Studio source can be found on [J GitHub under tag v1.6.0

About this release

CodeFusion Studio 1.0.0 is the first release of CodeFusion Studio. This release includes support for various

What's new

Tools

Pin Config Tool: Manage pin multiplexing and pin config choices in a graphical environment, before

o Clock Config Tool: Enable or disable the clock to various peripherals, and configure any dividers, muxes,
or intermediate steps in the clock tree.

» Quick Action Panel: Access quick links to perform common tasks like build, clean, flash, and debug.

o CFS Build Task Icons: Execute selected tasks for the active project with the status bar icons.

Zephyr's west , and more without any manual configuration.

SDK and software
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https://github.com/analogdevicesinc/codefusion-studio/releases/tag/V1.0.0/
https://github.com/analogdevicesinc/codefusion-studio/releases/tag/V1.0.0/
https://github.com/analogdevicesinc/codefusion-studio/releases/tag/V1.0.0/
https://docs.zephyrproject.org/3.7.0/
https://docs.zephyrproject.org/3.7.0/
https://docs.zephyrproject.org/3.7.0/
https://analogdevicesinc.github.io/msdk/USERGUIDE/
https://analogdevicesinc.github.io/msdk/USERGUIDE/
https://analogdevicesinc.github.io/msdk/USERGUIDE/

Host architecture support

CodeFusion Studio is supported on the following host operating systems:

o Windows 10 or 11 (64-bit)
« macOS (ARM64)
o Ubuntu 22.04 and later (64-bit)

Target architecture support

Introduced support for the following processors:

Processor MSDK Zephyr Pin Config
MAX32655 Yes - -
MAX32662 Yes - -
MAX32670 Yes - -
MAX32672 Yes - -
MAX32675 Yes - -
MAX32690 Yes Yes Yes
MAX78000 Yes - -
MAX78002 Yes - Yes

Clock Config

Yes

Known Issues

Project management issues

e No launch.json inimported Zephyr samples.
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https://www.analog.com/en/products/MAX32655.html
https://www.analog.com/en/products/MAX32662.html
https://www.analog.com/en/products/MAX32670.html
https://www.analog.com/en/products/MAX32672.html
https://www.analog.com/en/products/MAX32675.html
https://www.analog.com/en/products/MAX32690.html
https://www.analog.com/en/products/MAX78000.html
https://www.analog.com/en/products/MAX78002.html

e Zephyr samples do not have a launch.json generated when imported. When trying to debug, you will
be prompted to create a new launch.json file which you can modify as required.

Tools Issues

Clock speeds displayed in Clock Config tool

e The clock displayed on the canvas is the input clock to the peripheral and may not take into account
any internal clock dividers in the peripheral itself. Such internal clock dividers are generally configured
when initializing and configuring the peripheral in your application code.

Pin Config for MAX78002

and GPIO pins P8.28 or P@.29 disabled in the pin config tool.
Pin Config for MAX32690

e P0.18, P3.8,and P3.9 cannot be assigned or configured on the MAX32690 WLP. They can only be
used in the default power on mode (inputs, no pulls, using VDDIO).

Spurious compilation errors in headers

» Incomplete IntelliSense Configuration prevents IntelliSense scanning all include paths which may result
in false entries in the Problems tab. These can be ignored if the application builds successfully.

GPIO pull strength is inverted under Zephyr.

e The Zephyr 3.7 version of the MXC_GPIO_Config() function sets the pull strength inverted. When using
Zephyr, set the Select Pull-up/Pull-down field in the Pin Config tool to the opposite strength of what

you require:
Required Value Select in Config Tool Value of GPIOn_PS
Strong Pull-Up Weak Pull-Up 0
Weak Pull-Up Strong Pull-Up 1
Weak Pull-Down Strong Pull-Down 1
Strong Pull-Down Weak Pull-Down 0

@ Note

the GPIO pull select Ps register should be 0 when strong and 1 when weak.
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see any changes.

Debug issues

o Segger JLink does not support all parts. See the following table for details.

Part Issue Alternatives

MAX32662 Not supported Use MAXPICO debugger instead

MAX32670 Not supported Use MAXPICO debugger instead
MAX32690FTHR Serial output not available Use MAXPICO debugger if you need serial output
APARD32690 Serial output not available Use MAXPICO debugger if you need serial output
MAX78000FTHR Not supported Use MAXPICO debugger instead

MAX78002 Not supported Use MAXPICO debugger or MAX78000 instead

@ Note

When selecting a JLink session for the MAX78002, CodeFusion Studio will use a MAX78000 session implicitly
so no manual intervention is required.

» If debugging a dual core application and setting a breakpoint on the M4 that could also apply to the
RISC-V core such as a file and line combination or a symbol that is present in both images, then that

unique file or symbol name on each core or setting the breakpoints directly from the disassembly view.

« Another side effect of this is that the RISC-V appears to have 2 breakpoints set on main, so you may

need to run or step twice to run beyond the first line in your main function.
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